MP3 Files for Tape Groups

Cassette Tapes

Limited capacity
Bulky

Hard to position
Difficult to rewind

Difficult to organize
Must turn tape over
Quality degrades
Hard to copy

MP3 Files

HUGE capacity

Very compact

Instant random access
Instant precise rewind
Easy to organize
Unlimited recording
Maintains Quality
Easy & FAST to copy



MP3 Files for Tape Groups

Cassette Tapes

Limited capacity
Bulky

Hard to position
Difficult to rewind

Difficult to organize
Must turn tape over
Quality degrades
Hard to copy

MP3 Files

HUGE capacity

Very compact

Instant random access
Instant precise rewind
Easy to organize
Unlimited recording
Maintains Quality
Easy & FAST to copy



Required Equipment

Hardware Software
* Laptop 300 Mhz * dBpowerAMP Music
_ CD drive Converter
— Flash Drive * mp3DirectCut editor
e Patchbox/cables * Utagit tag editor
« Amplified Speakers * Winamp media player
e Remote Control * Wplayer
(optional) e RfRemote (optional)

* Visual CD (optional)



Computer Sound Systems

Not very standardized
* Number of input jacks
— Microphone
- Line
— Combined Line/Microphone
* How to enable/disable input sources
* Input levels required for Line or Microphone
e Stereo vs Mono input behavior
- Might need Mono to Stereo adapter cable



N DMC Auxiliary Input

"-""-_-, dBpowerAMP Music Converter - Auxiliary Input

Qt‘J & \\ Hecnrdj j Tracks Akt IEaIIer Genre j ear 27["3 j
-

Fecord Options  Test Becording Level  Album IF'.?caJuIEIE Comment [C3

Track | / =

Track
TrackDz2
TrackO3

Number Caller
[v] Tracki4 _ Dance : Level Year
Track0s | Of tips (f|Iename)

Track(Os
TrackO?
TrackOs
TrackO3
Track10
Trackll ll

| Coneerting 39 Tracks




N DMC Auxiliary Input Options

%, dB powerAM ™ Music Converter - Augiliary Input

‘_.-1'. . Fegfbord |99 = Tracks  Atist |Ealler Genre | ﬂ ear |2EI|:IE -
- B
Fecord Optiorns g Test Recording Level  2bum [Pacelulls Comment |3

Track ;{
v | Track
Atet WHEre to g What to
Track -
oo save files ,
v| Trackls Output Ta  [C:4My Documents'\Recardings Name f||eS
Aut 0 File Creation  |[artizt][track number wx)] Set
S'[al"[/ StOp \F Auto Start Record After WL is Ower |5 ZFor 750 ‘ms
¥] Track11 [v Auta End'when YU Drops Below |5_ % For |m dL =
Coneerting 39 Tracks .
Recard Uzing |[Default] ﬂ Quallty dOES
[hput Source Select | N OTH I N G

Quality [225KHz |

(] | Cancel |




“ Record (with options)

::""-J aope! :AMP Music Converter - Auxiliary Input

Album |Pacelullf

Genre |

El

Comment |E3

Tear |2EI|:IE -

Coneerting 39 Tracks

NEVER
check this!

E! dBpowerAMP Music Converter

Coriverting 99 Files to Mp3 [Lame]

Encoding: Constant Bitrate
Bit Rate: 32 Kbps

TR ename Files

Advanced Optionz |

N Ty |

[Ees=Buality - 5r. Mler File

/ﬂ[@k |M|:un|:| ﬂ
Output To:

(™) € 5Same Folder as Original

Bietter Quality - Larger File

Frequency |[22050 =| Hz

‘jl - K, Fecod [39 =] Tracks  Arist [Calle
ecordg?” Options  Test Recording Level
"= Select MP3
o Lame
o1 (default)
v | [rackla
W] Tpontns
<7 All Square
41 Dance Is
3 mono

_1 ' Falder il::'xM_l,l DocumentshRecordings

2 Yolume Mormalize
= V¥ Preserve ID Tags
@ I Delete Source Filsfs] After Conversion

< T &dd to dB powertMP Music Collection

Cancel |

- Browsze..

Bit rate slider
32 Kbps (note 1)

 [— —

Sample rate
22050 (note 1)

| —

Ty
%

PowerPack.

Note 1. These settings affect sound quality
and file size. This gives cassette tape quality.

Change this in
Options to make
permanent




N Test Recording Level

"-""-_-, dBpowerAMP Music Converter - Auxiliary Input

Qt‘J £ \\ 99 | Tracks  Ahist IEaIIer Genre j Tear |Z00B j

-n_-" e
Fecord Options #” Test Recording Level® 2bum [Pacelulls Comment [C3

Track
Track

TrackDz2
Trackl3 Action: Testing Recording L =
TrackO4

] Trackt5 0 i L—
TrackOE | |
TrackO? 3 End Test [ ptimal
TrackOa

TrackO9
Track10
Track11 ll

|Ennverting 99 Tracks CIICk Speaker tO
bring up Windows
Recording Control

Auriliany | mput




“  Recording Control

Genre E 2006 =]

X U, dBpowerAMP Music Com

Options->Properties
to select Recording

Y'ear

%‘!}l M\ 8 Record

Record Optiohs TESJ/F Camment [C3
i Properties -
Track ||
TrackDz2
lIEEY R Recording Control _ =] level s
[v] Track Options  Help
Track g 1|
Track Microphone Lire-ln CD-ROM Auziliany
|
Track Balance: Balance: Balance: Balance: ot ptimal
Track | | | | a
L A e AR A
¥ Track Yolume: Yolume: Wolume: Yolurme:
Tragk Wolume: olume: olume: alume: lI
|Ennverting ) | _ ) | _ ) _ ) _
[ Eelect v Select [T Select [T Select
Advanced |
|5|:|nin:: Impact &30 Mixer




“ Recording Control Properties

::";'-J dBpowerAMP Music Converter - Auxiliary Input

| Record |49 w | Tracks  Arkst [Caller Genre - Year [Z00B -
. L SN 4
Recod  Options  TestFecodnglevel  Album [Paceluids Comment [C3
Track. i‘
v | TrackOl
v| Tracklz
v| Trach Recording Control Properties "
7] T —_— . Make_ sure Recording
| Tracl Miner device: | Sy IS Selected
v| Tract  Microphane Lire-ln el v G
v| Tracl Balance: Balance
v| Tracl ﬁ:’ _J_ @ ﬁ:’ | £ Play
v| Tracl P 7 *" Becarding
v| Tracl _ _ ~
v Tract UDIHTE: _______ YW alurne: Otker J ChECk boxes for J

Coreeerting

Show the following valume contrals: = AL L VOI U m e CO ntrO IS —

= = = ¥ Telephone
:—|J: , ¥ Microphone
[ Select v Sele |1 O-ROM

Advanced 1 | | O K

Sonic Impact A30 kiker ] Ca




“  Recording Control

:;";'-j dBpowerAMP Music Converter - Auxiliary Input

".u_.‘!, T W Record |99 = Tracks  Atist |Ealler Genre | ﬂ Tear |2EI|:IE -
Recod  Options  TestFecodnglevel  Album [Paceluids Comment [C3
Track i‘
v| Trackll
v | TrackD2 .
LAMIE=S EZ R ecording Control M= E
vITrack " Options  Help
v| Track
v| Track  Telephone Microphione Line-lr . tereohdixer Monobdixer
v| Track  Balance: B alance: B alance: SeleCt ONLY the InpUt alance: Balance:
| Track "
SRS s S R R T you will use et Pl
v | Track ( I I )
| Track Wolurme: Wolurme: alurmne: Llne Or Mlcrophone olurne: alurmne: j
Converting ~ ~ | - | :‘: 1 :‘: s I
: ‘ - T - :T: - :T: :T:
[ Select [ Select [v Select [ Select [ Select [ Select [ Select [ Select

Advanced |

Sonic Impact 430 Miker

Some computers allow multiple inputs to be selected at same time!



“ Recording Control Properties

:;";'-j dBpowerAMP Music Converter - Auxiliary Input

"-'__J. T WN Record |99 = Tracks  Atist |Ealler Genre | ﬂ Y'ear m
HE-'EE:rd Optictis : . : Commert ||:3

o Options->Properties j
v | TrackOl ag a|n

v | Trackl:

LARIEES 52 R ecording Control | Properties

v | Track] Ooti

ptionz  Help . .

| Track = Mixer device: |5|:|nic:lm|:|a|::t 430 Miver ﬂ

v| Track. Telephone Micropl et s o s eilizrn Chereohdixer Mook ixer

v| Track! Balance: B alanc alance; B alance:

v | Track! @’ _J_ "‘\IF @: | £ Playback UnCheCk a.” bOXES o - l_ <E| @: _J_ '{U

v | Track! Vi | + Recording except the one you Vi Vi

v | Track’

| Track: Yalume: Volume | ¢ Other are US|ng olurme: Wolume: =|
Caorveerting o _ T o

| | _ Show the: fallowing volume contoe: - ‘ -

CIE R E

[ Select [ Sel CO-ROM [ Select [ Select

Adva 1 | | OK

Sonic Impact 430 Miker ] Ca




N Recording Control %

You now have

QJ‘J & \\ Record . Genre j Year |2006 j
HEE'.‘:.‘r.j Optictis Test f Slngle VOIUme Comment |C3

T ] control R

TrackO -
TrackOz
Track 5 )
Track
Track WU beter L g—
Track  Lineln | |
&k B alance: ¥ End Test S
Track K ELiliany [ Hput
Track ;

Track
Track

¥ U, dBpowerAMP Music Com

Action: Testing Recording Lewvel

|Ennverting _ | _
| Adjust volume

-I-' level and click
" End Test

W Select

|S|:|r'|in: Irmpact &30 ki




% Recording

ﬂ [0%] dBpowerAMP Music Converter >

Count “tips”
recorded

Corvverting File 1 of 33 to Mp3 [Lame)

Action: Conwerting 07"

0% Completed

97 Sarnnd= Elapzed
Re... M[E Achion: W ating to Record 'Trackdl’ [Z] |
Optiohz  Help EE—
Wi keter
Line-In
Balance: °
R— Fecofd
b iy
Yalurne
| Recording level
ZTZ (peaks 1/2 to 2/3) _
o Close window to
¥ Select stop recording
Sonic Impact 230 Mi: AdJUSt Ievel




. Mp3DirectCut %.




. Mp3DirectCut Select Start %

-,m Ceder01_mp3 - mp3DirectCut
File Edit Special List Sethings ¢

Drag and Drop
to open MP3 file

ﬂ;:n.dmm

- :
ud Click and Drag
| s | e | st | in | [Total 95988 Now 04883 (7] to select

4 | wry l..<< wrl Out | Selection: 0'00.00 - 0'45.74 [0'45.74)
Edit Audio Spacebar
Cut Edit o L Y Y toggles
Set beqin Set end Few Stop Plav—{— Bec || F)Iay/StOp to
MPEGZ.0 Layer 3. 32 kbps, 22 kHz, Mono listen




. Mp3DirectCut Cut Start %.

m Ceder01_mp3 - mp3DirectCut

File Edit Special List Sethings ¢

A

M 3
4 > | # In Total 97414 Mow: 0'01.15 [0%]
400 | e g | 2.l Out Fange [1/1): 0°00.00 - 974.14 (57 4.14)

Selection
vanishes!

......................................

Set begin | Set end

dir

| MPEGZ.0 Layer 3, 32 kbpz, 22 kHz, Mono

Edit will 1=

M argin

Rec

bring it back =




. Mp3DirectCut Select End %

-,E-. Ceder01_mp3 - mp3DirectCut

File  Edit Special Lzt Sethngs

&

R
M aw
£ . e N =
< | ownn |..<x 55 | u
E dit
Lut Edit
Set EEEIir‘l ....... SE-'tE:ﬂd .........

......................................

MPEGZ.0 Layer 3, 32 kbpz, 22 kHz, Mono

| Total 31414 Mow: 85308 [96%)

| Selection: 8'53.73 - 314,14 [0°20.40]

Audio
=>I..| [=>.. ..=:>I| == =x|.. |=3

Select “quiet”
at end

Rew Stop Flay




. Mp3DirectCut Cut End %

m Ceder01_mp3 - mp3DirectCut

File Edit Special List Sethings ¢

ud Selection
e | s | ik | st | In | [Total 85373 Now 85308 (9% vanishes!
400 | e g | 2.l Out Fange [1/1): 0'00.00 - 3'53.73 [8'53.73)
Audio
Edit =:l | = = = == M argin
Set begin Set end Rew Stop Flay Rec

| MPEGZ.0 Layer 3, 32 kbpz, 22 kHz, Mono i



. Mp3DirectCut Cut Normalize %.

m Ceder01_mp3 - mp3DirectCut
File | Edit Special List Setbngs 2

Tag D3 and file info... Chrl+l

Cuk Chrl+

Copy Clrl+C

Faste Chrl+f

Undo selection change Ctrl+ .

Hemove zelection Ctrl+R N orm al | Ze to
Select Al Chrl+a, maxXimize

Select current part
Remove selected elements

Gain... T+
kY CileF i

Create zimple fade

signal level

Mormalize. .. Chrl+hd
_ % Pause detection. . 73 Mow: 35308 [99%)
4 Mames and part properties. . Cl+td ) 0'00.00 - 853,73 [8'53.73)

Set Cue flag for all zimple split pointz
~Edt———————————————— o

Cuat Edit =:l | = = = == M argin

Set begin Set end Rew Stop Flay Rec

| MPEGZ.0 Layer 3, 32 kbpz, 22 kHz, Mono i



. Mp3DirectCut Cut Normalize %.

m Ceder01_mp3 - mp3DirectCut
File Edit Special List Sethings ¢

|
Seeking madimumm gain. This may take a while,

becausze data muszt be internally decoded [Mote:
ALK 1= fazter than mpglib.dll).

Mormalize zelection

ANERERENERENNNENNEREEEREEEN] Te”S hOW much

dB
48 level increased
Peak found: -1.8dB
0| Level change: +1.5dE
Rl ]
Y - 24 QK. Cancel
a
<4 > |+ 5 In Tatal 853,73 MNow: 8'53.08 [99%)
400 | e g | 2.l Out Fange [1/1): 0'00.00 - 3'53.73 [8'53.73)
Audio
Edit =:l | = = = == M argin
Set begin Set end Hew Stop Flay Rec

| MPEGZ.0 Layer 3, 32 kbpz, 22 kHz, Mono i



Keeping MP3 Files Organized

@% C:\Documents and 5ettings\Keith\My Documents\Rec... =] E3

o Fi I e n am i n g CO nve nti O n File  Edit Wiew Favorites  Toolz Help : | fr.'

>
Address I_;' d1B\C 3t TrailblazerDec03Ceder _:J a Go '\j -

. Back

* Folder naming e
E|...:| CdiE :I | 01 Ceder.mp3
= L | 02Ceder.mp3

a2

¢ Organlze by Level, B0 O =] 03Ceder mp3
B 02 +| D4Ceder.mp3
Dance, Caller = ) 5Cederno3
B3 Ca | OBCeder.mp3
----- () PacefugD3FrenchSmith 2] O7Ceder. mp3

e Searchin g i ) PaceFebldFeleay =) DBCeder mp3

----- {7 PacelanldHawell
| I T ) PaceMarl4)acobs

o 3 3 g ---- ) Pace0ctlEFellagy
I\/I P I D Vl a S ----- {71 PaceSepl3Rubnght
""" i) Phantomz0cti3)acobs

o < B ----- {21 PhantomeSepl3FrenchSmith
eep ackups W T r2ilblazerD ec3Ceder

----- {2 TrailblazerFeb04FrenchSmith

----- {=) Trailblazer) an04R ubright

® <ee o BaC (U OS ----- {2 Trailblazertd arldalexander

----- {3 Trailblaze o 03Lightly
----- {2 TrailblazerQct0E3k chtes

o Keep Backups = £ o] |z ]
o

2 objectz I23.4 B I J ty Computer




Taglt UTag |t Taglt

B UT agit =
Fil=  Help
Mode: ¢ Edit ¢ View © Update & Auto Update Undate | Auta
Replace selected tags, Updated immediately pdate Increment
Track: 1 v v
Genre:  |[hone) | ¥
st Ceder v -
Alburn: Pacelunls ™ -
Dance
‘ear: 2006 v
L evel ~Loaomment: |C3a v m

Lpdate |

Drag and Drop files onto Utagit window to edit the MP3 ID3v1 tags.



MP3 ID3v1 Tags

Permanently label files with useful data

— Artist (caller)

- Album (dance)

- Comment (level, etc.)

- Year
Windows Explorer can display tags in columns

Programs can search based on tags
|dentifies file even if moved to wrong folder
Media players can display MP3 tag information



Winamp

Player

Equalizer

Playlist

(shows tags)

Optional
Plugins

Pacemaker ¥1.1

— Cantrol
Tempo | +100%
Fitzh + [0.00 oct
&
Speed +0 %
&

WINAMF

kHz mono &b

W

HEEEN S s o

WINAMP EQUALIZER =W/~

mm—
— g —*ledh — g - & - & -
-

ode —H - “F--

-B -
—I—-lE:II: —l—I I I I I I

FREAHF B0 IO S0 600 [ SE

————— WINAMPF PLAYLIST — =

1. Ceder - TrackD1 C3

2. Ceder - Trac 35

3. Ceder - Trac

4. Ceder - Trac

5. Ceder - Track(

5. Ceder - Trac
Ceder - Trac

TrackOs C

mEEE

T
&
&
o)
38
&
a
35

Ei Ceder -




Whplayer

# wWplayer - C:\Documents and Settings\Keith\My Documents\Re... [H[El E3

File Edt Play Options Help

- Flaylist CADocurnents and Seftingshkeithi My
Position from | Paying  [10f42 1 Ceder- Track0l C4 - Winamp
start of file @ Position 10:50  Tip Length 11:48
Counter Tip Timer
Position Time left in
from Zero \e : 1 2 1 1 - 47/ tip
Buttons and Play/Pause Tip Tirner Sound Off
shortcuts - 2 RN Visual
(End/F9Z)  (Home/F11/R) : : i
for most ol ——— Indication
functions o at end of tip
=<<=Last Tip Mext Tip==
(FE/P) (F7/N)




£ Wplayer Features %@

 “Tape” counter to mark start of sequence

* Instant rewind back to zero

* Tip timer, reminds you when to rotate dancers in
* Auto backup after pause (never miss a word)

* Convenient keyboard shortcuts (e.g. Spacebar for
nlay/pause)

* Resumes at last zero when file opened again

* Programmable tip timer sound (have fun)
* BIG position and timer displays, easy to read



£ \Wplayer and Winamp Operation £

Add files to Winamp playlist (drag/drop files/folders)
Save Winamp playlist file (m3u file)

Open playlist with Wplayer (Play->Open Playlist)
Save tape group file with Wplayer (File->Save As)

Now Woplayer will remember last zero position when
It Is closed.

Open tape group file (grp file) with Wplayer, or drag
and drop grp file to Wplayer, and it resumes from
where you left off

Keep multiple playlists and tape group files.
Wohplayer knows where you left off on each one!



6 RF Remote Control 6

RF overcomes line-of-sight problems of IR remote
controls

No one needed to sit and run the computer
No problem if there are only 8 people

Play/Pause, skip Forward/Back, Zero, Rewind, Tip
Timer all controlled by remote control

Receilver connects via USB

Transmitter attaches to belt

Compatible with Windows 98 through XP

General purpose, control any Windows application
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